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1.  Introduction 
The 883M is a high-precision triaxial MEMS vibration sensor that 
simultaneously detects overall, True-peak, temperature, time waveform, FFT 
spectrum, and other values. Its robust and reliable design, and 
communication through standard RS485 interface and Modbus RTU 
protocols make it ideal for applications in semiconductor industry equipment 
condition monitoring, predictive maintenance, and automated integration. 

1.1 Features 
 Triaxial synchronous measurement with real-time status indication 

through LED lights. 
 Detection overall of vibration acceleration, velocity (ISO 10816, ISO/TR 

17243-1), and displacement. 
 Synchronous measurement of temperature. 
 Extraction of time-domain waveforms and calculation of FFT spectra. 
 Detection of True-peak for real-time prediction of bearing condition. 
 IP67 design suitable for harsh environments and clean room process 

areas. 

1.2 Applications 
 Monitoring of semiconductor industry and advanced process equipment 

condition. 
 Industrial automation process monitoring. 
 Monitoring of machine tools in machining processes. 
 Integration applications of IoT and big data. 
 Monitoring of operational condition in transportation vehicles and 

aircraft. 
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2.  Specification 

2.1 Measurement Specification 
Dynamic    
Axis Triaxial 
Acceleration Range ±16 g-peak 
Resolution 0.488mg 
Frequency Range 2Hz~5kHz 
Output Data 
Displacement RMS 2Hz~1kHz, 10Hz~1kHz 
Displacement Peak 2Hz~1kHz, 10Hz~1kHz 
Velocity RMS 10Hz~1kHz, 10Hz~5kHz, 2Hz~1kHz 
Velocity Peak 10Hz~1kHz, 10Hz~5kHz, 2Hz~1kHz 
Acceleration RMS  2Hz~1kHz, 10Hz~5kHz 
Acceleration Peak 2Hz~1kHz, 10Hz~5kHz 
Temperature -20°C～70°C 
True peak Fs @ 13.333kHz 
Spectrum 0Hz~5kHz, Lines=6145 
Timewave 13,333 samples, 1 second 
Other Features Crest Factor, Standard Deviation 
Communication 
Interface RS485 
Protocol Modbus RTU 
Max. baud rate 921600 bps 
Electrical 
Power 6VDC~24VDC 
LED Indicator 1 (RGB) 
Environmental and Mechanical 
Dimension Ø 35 x 26 mm 
Weight 75 grams (Body) 
IP Rating IP67 
Connector M8 4 pin Female connector 
Mounting Adhesive, bolt/screw & magnet 
Operation Temperature -20°C～70°C 
Storage Temperature -20°C～80°C  
Operation Humidity 5%~95% RH 
Certification CE 

 



3 
 

2.2 Sensor Measurement Direction Definition 

         
      Top View                 Left Side View 

 
Fig. 2.2 Sensor Measurement Direction Definition 

 

2.3  Sensor Pin Definition 

 

 
 
 
 

 
                                                  
 
 

                                                  *HOUSING 
Table 2.3 Sensor Pin Definition 

Pin Definition 

1 Power 6~24V 

2 Ground 

3 Signal + 

4 Signal - 

5* Shielding 

1 

3 

2 

4 

5 
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2.4  Cable Pin Definition (Optional) 

 
PIN Color Definition 

1 Red Power 6~24V 

2 Black Ground 

3 Green Signal + 

4 White Signal - 

5* -- Shielding 
                                                *HOUSING 

Table 2.4 Cable Pin Definition 

 

2.5  Sensor LED Indicator 
 

 

 
 
 
 
 

Table 2.5 Sensor LED Indicator 

Item Status Description 
 White Light 

Briefly On 

Power-on and 
self-test in 
progress 

 Blue Light 
Flashing Standby mode 

 Green Light 
Flashing 

Data 
transmission in 
progress 

 Blue Light 
Constantly On 

Sensor 
abnormality 
detected 

 Red Light 
Flashing 

Firmware 
update in 
progress 

1 2 

3 4 5 
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2.6 Recommended Topologies 

 

Star Topology 

 RS-485 
HOST 

RS-485 
Hub 

RS-485 
Hub 

Bus Topology: 

When multiple 883M units need to be installed, it is 
advisable to connect an RS-485 Hub to the RS-485 bus, 
forming a star topology to enhance data transmission 
stability in the RS-485 network. 

When using bus topology, minimize the length of RS-485 
stub branches, lower the baud rate for 883M data 
transmission, or add a termination resistor at the end of the 
RS-485 bus to enhance data transmission stability. 

RS-485 
HOST 
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3. 883M Utility 

 
 *Note: The most current version of the utility is available on the Wilcoxon 

website at wilcoxon.com/883M. 
Fig. 3. 883M Utility 

 

3.1 Setup and Measurement Procedures 
Users can connect the 883M sensor to a computer using the included 
883M Utility software and an RS485 to USB converter (optional) to 
configure communication protocols, update firmware, and view 
vibration data. 

 
Fig. 3.1 RS485 to USB Adapter 

https://wilcoxon.com/883m/
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3.1.1 Connection Settings 

Connection > Search > Scan > Slave ID > Connect 

 
Fig. 3.1.1 Connection Setting 

 

3.1.2 Communication Protocol Configuration 

Sensor Setup > 883M Setting > Edit > Write to Sensor 

 
Fig. 3.1.2 Communication Protocol Configuration 
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3.1.3 View Vibration Data 

View > Measurement View > Start 

 
Fig. 3.1.3 View Vibration Data 

3.1.4 View Overall Trend Data 

View > Trend View > Start 

 
Fig. 3.1.4 View Vibration Data 
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3.1.5 View Time Waveform and FFT Spectrum 

Measure (Waveform / FFT) 

 
Fig. 3.1.5 View Time Waveform and FFT Spectrum 

 

3.1.6 Export Overall Vibration as CSV 

Start > Export CSV 

 
Fig. 3.1.6 Export Overall Vibration as CSV File 
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3.1.7 Export Time Waveform and FFT Spectrum as CSV 

Measure (Waveform / FFT) > Export CSV 

 
Fig. 3.1.7 Export Time Waveform and FFT Spectrum as CSV File 

3.1.8 Waveform Size and FFT Bandwidth Settings 

View > Measurement View > Edit Value (before Start) 

 
Fig. 3.1.8 View Size and Bandwidth Settings 
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3.2 Update Firmware 

Sensor Setup > 883M Setting > Update Firmware 

 
Fig. 3.2 Update Firmware 
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4.  Modbus RTU Format 
Slave ID Function Code Data CRC 

1 byte 1 byte 0 up to 252 bytes 2 bytes 

Table 4. Modbus RTU Format 

5.  Code Table 

Code (Hex) Definition Description 

0x03 Read Holding Table  
Read current sensor 
settings 

0x04  Read Input Table  
Read measurement 
data 

0x06  Write Single Register  
Modify individual 
sensor settings 

0x10  Write Multiple Registers  
Modify multiple sensor 
settings 

0x2B  Read Device ID  Read sensor ID 
0x80  Exception Responses  Error codes 

Table 5. Code Table 

  
Fig. 5. Explanation of the Difference between Code 0x03 and 0x2B 

 

0x2B Table 

0x03, 0x06, 0x10 
Table 
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6.  0x03(3) Function Code Details 
Address Data Format Default Description 

0x0000 unsigned int16 0x0009 

Baud Rate: 
0x0006:1200 bps 
0x0007:2400 bps 
0x0008:4800 bps 
0x0009:9600 bps 
0x000A:19200 bps 
0x000B:38400 bps 
0x000C:57600 bps 
0x000D:115200 bps 
0x000E:230400 bps 
0x000F: 460800 bps 
0x0010: 921600 bps 

0x0001 unsigned int16 0x0008 
Data Bits: 
0x0008: 8 bits 

0x0002 unsigned int16 0x0000 

Data Parity: 
0x0000: None 
0x0001: Even 
0x0002: Odd 

0x0003 unsigned int16 0x0001 
Stop Bits: 
0x0001: 1 bit 
0x0002: 2 bits 

0x0004 unsigned int16 0x0001 
Modbus Slave ID: 
0x0001~0x00F7: 1~ 247 

0x0200 unsigned int16 0xEEEE 

Table Data Ready for Read 
 
When register value=0x0000, use the 
function code 0x04 to get 
corresponding data. 

Table 6. 0x03(3) Function Code Details 
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Fig. 6. Read 0x03(3) Function Code Flowchart (Refer to MODBUS APPLICATION 

PROTOCOL SPECIFICATION V1.1b) 
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7.  0x04(4) Function Code Details 
Measurement Value (Metric) 

Address Data Format Unit Description 
0x0000 unsigned int16 0.01 g Acceleration (2Hz~1kHz) RMS, X 
0x0001 unsigned int16 0.01 g Acceleration (2Hz~1kHz) RMS, Y 
0x0002 unsigned int16 0.01 g Acceleration (2Hz~1kHz) RMS, Z 
0x0003 N/A N/A (Read Return 0x0000) 
0x0004 unsigned int16 0.01 g Acceleration (2Hz~1kHz) Peak, X 
0x0005 unsigned int16 0.01 g Acceleration (2Hz~1kHz) Peak, Y 
0x0006 unsigned int16 0.01 g Acceleration (2Hz~1kHz) Peak, Z 
0x0007 N/A N/A (Read Return 0x0000) 
0x0008 unsigned int16 0.1 m/s^2 Acceleration (2Hz~1kHz) RMS, X 
0x0009 unsigned int16 0.1 m/s^2 Acceleration (2Hz~1kHz) RMS, Y 
0x000A unsigned int16 0.1 m/s^2 Acceleration (2Hz~1kHz) RMS, Z 
0x000B N/A N/A (Read Return 0x0000) 
0x000C unsigned int16 0.1 m/s^2 Acceleration (2Hz~1kHz) Peak, X 
0x000D unsigned int16 0.1 m/s^2 Acceleration (2Hz~1kHz) Peak, Y 
0x000E unsigned int16 0.1 m/s^2 Acceleration (2Hz~1kHz) Peak, Z 
0x000F N/A N/A (Read Return 0x0000) 
0x0010 unsigned int16 0.01 g Acceleration (10Hz~5kHz) RMS, X 
0x0011 unsigned int16 0.01 g Acceleration (10Hz~5kHz) RMS, Y 
0x0012 unsigned int16 0.01 g Acceleration (10Hz~5kHz) RMS, Z 
0x0013 N/A N/A (Read Return 0x0000) 
0x0014 unsigned int16 0.01 g Acceleration (10Hz~5kHz) Peak, X 
0x0015 unsigned int16 0.01 g Acceleration (10Hz~5kHz) Peak, Y 
0x0016 unsigned int16 0.01 g Acceleration (10Hz~5kHz) Peak, Z 
0x0017 N/A N/A (Read Return 0x0000) 
0x0018 unsigned int16 0.1 m/s^2 Acceleration (10Hz~5kHz) RMS, X 
0x0019 unsigned int16 0.1 m/s^2 Acceleration (10Hz~5kHz) RMS, Y 
0x001A unsigned int16 0.1 m/s^2 Acceleration (10Hz~5kHz) RMS, Z 
0x001B N/A N/A (Read Return 0x0000) 
0x001C unsigned int16 0.1 m/s^2 Acceleration (10Hz~5kHz) Peak, X 
0x001D unsigned int16 0.1 m/s^2 Acceleration (10Hz~5kHz) Peak, Y 
0x001E unsigned int16 0.1 m/s^2 Acceleration (10Hz~5kHz) Peak, Z 
0x001F N/A N/A (Read Return 0x0000) 
0x0020 unsigned int16 0.1 mm/s Velocity (10Hz~1kHz) RMS, X 
0x0021 unsigned int16 0.1 mm/s Velocity (10Hz~1kHz) RMS, Y 
0x0022 unsigned int16 0.1 mm/s Velocity (10Hz~1kHz) RMS, Z 
0x0023 N/A N/A (Read Return 0x0000) 
0x0024 unsigned int16 0.1 mm/s Velocity (10Hz~1kHz) Peak, X 
0x0025 unsigned int16 0.1 mm/s Velocity (10Hz~1kHz) Peak, Y 
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0x0026 unsigned int16 0.1 mm/s Velocity (10Hz~1kHz) Peak, Z 
0x0027 N/A N/A (Read Return 0x0000) 
0x0028 unsigned int16 0.1 mm/s Velocity (10Hz~5kHz) RMS, X 
0x0029 unsigned int16 0.1 mm/s Velocity (10Hz~5kHz) RMS, Y 
0x002A unsigned int16 0.1 mm/s Velocity (10Hz~5kHz) RMS, Z 
0x002B N/A N/A (Read Return 0x0000) 
0x002C unsigned int16 0.1 mm/s Velocity (10Hz~5kHz) Peak, X 
0x002D unsigned int16 0.1 mm/s Velocity (10Hz~5kHz) Peak, Y 
0x002E unsigned int16 0.1 mm/s Velocity (10Hz~5kHz) Peak, Z 
0x002F N/A N/A (Read Return 0x0000) 
0x0030 unsigned int16 um Displacement (2Hz~1kHz) RMS, X 
0x0031 unsigned int16 um Displacement (2Hz~1kHz) RMS, Y 
0x0032 unsigned int16 um Displacement (2Hz~1kHz) RMS, Z 
0x0033 N/A N/A (Read Return 0x0000) 
0x0034 unsigned int16 um Displacement (2Hz~1kHz) Peak, X 
0x0035 unsigned int16 um Displacement (2Hz~1kHz) Peak, Y 
0x0036 unsigned int16 um Displacement (2Hz~1kHz) Peak, Z 
0x0037 N/A N/A Reserved (read return 0x0000) 
0x0038 unsigned int16 um Displacement (10Hz~1kHz) RMS, X 
0x0039 unsigned int16 um Displacement (10Hz~1kHz) RMS, Y 
0x003A unsigned int16 um Displacement (10Hz~1kHz) RMS, Z 
0x003B N/A N/A (Read Return 0x0000) 
0x003C unsigned int16 um Displacement (10Hz~1kHz) Peak, X 
0x003D unsigned int16 um Displacement (10Hz~1kHz) Peak, Y 
0x003E unsigned int16 um Displacement (10Hz~1kHz) Peak, Z 
0x003F N/A N/A (Read Return 0x0000) 
0x0040 unsigned int16 0.01 g True peak, X 
0x0041 unsigned int16 0.01 g True peak, Y 
0x0042 unsigned int16 0.01 g True peak, Z 
0x0043 N/A N/A (Read Return 0x0000) 
0x0044 unsigned int16 0.01 Crest Factor, X 
0x0045 unsigned int16 0.01 Crest Factor, Y 
0x0046 unsigned int16 0.01 Crest Factor, Z 
0x0047 N/A N/A (Read Return 0x0000) 
0x0048 unsigned int16 0.01 Standard Deviation, X 
0x0049 unsigned int16 0.01 Standard Deviation, Y 
0x004A unsigned int16 0.01 Standard Deviation, Z 
0x004B N/A N/A (Read Return 0x0000) 
0x004C signed int16 0.01 g DC Acceleration, X 
0x004D signed int16 0.01 g DC Acceleration, Y 
0x004E signed int16 0.01 g DC Acceleration, Z 
0x004F N/A N/A (Read Return 0x0000) 
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0x0050 signed int16 0.1 °C Temperature 
0x0051 N/A N/A (Read Return 0x0000) 
0x0052 N/A N/A (Read Return 0x0000) 
0x0053 N/A N/A (Read Return 0x0000) 
0x0054 N/A N/A (Read Return 0x0000) 
0x0055 N/A N/A (Read Return 0x0000) 
0x0056 N/A N/A (Read Return 0x0000) 
0x0057 N/A N/A (Read Return 0x0000) 
0x0058 N/A N/A (Read Return 0x0000) 
0x0059 N/A N/A (Read Return 0x0000) 
0x005A N/A N/A (Read Return 0x0000) 
0x005B N/A N/A (Read Return 0x0000) 
0x005C N/A N/A (Read Return 0x0000) 
0x005D N/A N/A (Read Return 0x0000) 
0x005E N/A N/A (Read Return 0x0000) 
0x005F N/A N/A (Read Return 0x0000) 
0x0060 N/A N/A (Read Return 0x0000) 
0x0061 N/A N/A (Read Return 0x0000) 
0x0062 N/A N/A (Read Return 0x0000) 
0x0063 N/A N/A (Read Return 0x0000) 
0x0064 unsigned int16 0.1 mm/s Velocity (2Hz~1kHz) RMS, X 
0x0065 unsigned int16 0.1 mm/s Velocity (2Hz~1kHz) RMS, Y 
0x0066 unsigned int16 0.1 mm/s Velocity (2Hz~1kHz) RMS, Z 
0x0067 N/A N/A (Read Return 0x0000) 
0x0068 unsigned int16 0.1 mm/s Velocity (2Hz~1kHz) Peak, X 
0x0069 unsigned int16 0.1 mm/s Velocity (2Hz~1kHz) Peak, Y 
0x006A unsigned int16 0.1 mm/s Velocity (2Hz~1kHz) Peak, Z 

    
Measurement Value (Imperial) 

Address Data Format Unit Description 
0x0100 unsigned int16 0.01 g Acceleration (2Hz~1kHz) RMS, X 
0x0101 unsigned int16 0.01 g Acceleration (2Hz~1kHz) RMS, Y 
0x0102 unsigned int16 0.01 g Acceleration (2Hz~1kHz) RMS, Z 
0x0103 N/A N/A (Read Return 0x0000) 
0x0104 unsigned int16 0.01 g Acceleration (2Hz~1kHz) Peak, X 
0x0105 unsigned int16 0.01 g Acceleration (2Hz~1kHz) Peak, Y 
0x0106 unsigned int16 0.01 g Acceleration (2Hz~1kHz) Peak, Z 
0x0107 N/A N/A (Read Return 0x0000) 
0x0108 N/A N/A (Read Return 0x0000) 
0x0109 N/A N/A (Read Return 0x0000) 
0x010A N/A N/A (Read Return 0x0000) 
0x010B N/A N/A (Read Return 0x0000) 
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0x010C N/A N/A (Read Return 0x0000) 
0x010D N/A N/A (Read Return 0x0000) 
0x010E N/A N/A (Read Return 0x0000) 
0x010F N/A N/A (Read Return 0x0000) 
0x0110 unsigned int16 0.01 g Acceleration (10Hz~5kHz) RMS, X 
0x0111 unsigned int16 0.01 g Acceleration (10Hz~5kHz) RMS, Y 
0x0112 unsigned int16 0.01 g Acceleration (10Hz~5kHz) RMS, Z 
0x0113 N/A N/A (Read Return 0x0000) 
0x0114 unsigned int16 0.01 g Acceleration (10Hz~5kHz) Peak, X 
0x0115 unsigned int16 0.01 g Acceleration (10Hz~5kHz) Peak, Y 
0x0116 unsigned int16 0.01 g Acceleration (10Hz~5kHz) Peak, Z 
0x0117 N/A N/A (Read Return 0x0000) 
0x0118 N/A N/A (Read Return 0x0000) 
0x0119 N/A N/A (Read Return 0x0000) 
0x011A N/A N/A (Read Return 0x0000) 
0x011B N/A N/A (Read Return 0x0000) 
0x011C N/A N/A (Read Return 0x0000) 
0x011D N/A N/A (Read Return 0x0000) 
0x011E N/A N/A (Read Return 0x0000) 
0x011F N/A N/A (Read Return 0x0000) 
0x0120 unsigned int16 0.01 inch/s Velocity (10Hz~1kHz) RMS, X 
0x0121 unsigned int16 0.01 inch/s Velocity (10Hz~1kHz) RMS, Y 
0x0122 unsigned int16 0.01 inch/s Velocity (10Hz~1kHz) RMS, Z 
0x0123 N/A N/A (Read Return 0x0000) 
0x0124 unsigned int16 0.01 inch/s Velocity (10Hz~1kHz) Peak, X 
0x0125 unsigned int16 0.01 inch/s Velocity (10Hz~1kHz) Peak, Y 
0x0126 unsigned int16 0.01 inch/s Velocity (10Hz~1kHz) Peak, Z 
0x0127 N/A N/A (Read Return 0x0000) 
0x0128 unsigned int16 0.01 inch/s Velocity (10Hz~5kHz) RMS, X 
0x0129 unsigned int16 0.01 inch/s Velocity (10Hz~5kHz) RMS, Y 
0x012A unsigned int16 0.01 inch/s Velocity (10Hz~5kHz) RMS, Z 
0x012B N/A N/A (Read Return 0x0000) 
0x012C unsigned int16 0.01 inch/s Velocity (10Hz~5kHz) Peak, X 
0x012D unsigned int16 0.01 inch/s Velocity (10Hz~5kHz) Peak, Y 
0x012E unsigned int16 0.01 inch/s Velocity (10Hz~5kHz) Peak, Z 
0x012F N/A N/A (Read Return 0x0000) 
0x0130 unsigned int16 0.1 mil Displacement (2Hz~1kHz) RMS, X 
0x0131 unsigned int16 0.1 mil Displacement (2Hz~1kHz) RMS, Y 
0x0132 unsigned int16 0.1 mil Displacement (2Hz~1kHz) RMS, Z 
0x0133 N/A N/A (Read Return 0x0000) 
0x0134 unsigned int16 0.1 mil Displacement (2Hz~1kHz) Peak, X 
0x0135 unsigned int16 0.1 mil Displacement (2Hz~1kHz) Peak, Y 
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0x0136 unsigned int16 0.1 mil Displacement (2Hz~1kHz) Peak, Z 
0x0137 N/A N/A (Read Return 0x0000) 
0x0138 unsigned int16 0.1 mil Displacement (10Hz~1kHz) RMS, X 
0x0139 unsigned int16 0.1 mil Displacement (10Hz~1kHz) RMS, Y 
0x013A unsigned int16 0.1 mil Displacement (10Hz~1kHz) RMS, Z 
0x013B N/A N/A (Read Return 0x0000) 
0x013C unsigned int16 0.1 mil Displacement (10Hz~1kHz) Peak, X 
0x013D unsigned int16 0.1 mil Displacement (10Hz~1kHz) Peak, Y 
0x013E unsigned int16 0.1 mil Displacement (10Hz~1kHz) Peak, Z 
0x013F N/A N/A (Read Return 0x0000) 
0x0140 unsigned int16 0.01 g True Peak, X 
0x0141 unsigned int16 0.01 g True Peak, Y 
0x0142 unsigned int16 0.01 g True Peak, Z 
0x0143 N/A N/A (Read Return 0x0000) 
0x0144 unsigned int16 0.01 Crest Factor, X 
0x0145 unsigned int16 0.01 Crest Factor, Y 
0x0146 unsigned int16 0.01 Crest Factor, Z 
0x0147 N/A N/A (Read Return 0x0000) 
0x0148 unsigned int16 0.01 Standard Deviation, X 
0x0149 unsigned int16 0.01 Standard Deviation, Y 
0x014A unsigned int16 0.01 Standard Deviation, Z 
0x014B N/A N/A (Read Return 0x0000) 
0x014C signed int16 0.01 g DC Acceleration, X 
0x014D signed int16 0.01 g DC Acceleration, Y 
0x014E signed int16 0.01 g DC Acceleration, Z 
0x014F N/A N/A (Read Return 0x0000) 
0x0150 signed int16 0.1 °F Temperature 
0x0151 N/A N/A (Read Return 0x0000) 
0x0152 N/A N/A (Read Return 0x0000) 
0x0153 N/A N/A (Read Return 0x0000) 
0x0154 N/A N/A (Read Return 0x0000) 
0x0155 N/A N/A (Read Return 0x0000) 
0x0156 N/A N/A (Read Return 0x0000) 
0x0157 N/A N/A (Read Return 0x0000) 
0x0158 N/A N/A (Read Return 0x0000) 
0x0159 N/A N/A (Read Return 0x0000) 
0x015A N/A N/A (Read Return 0x0000) 
0x015B N/A N/A (Read Return 0x0000) 
0x015C N/A N/A (Read Return 0x0000) 
0x015D N/A N/A (Read Return 0x0000) 
0x015E N/A N/A (Read Return 0x0000) 
0x015F N/A N/A (Read Return 0x0000) 
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0x0160 N/A N/A (Read Return 0x0000) 
0x0161 N/A N/A (Read Return 0x0000) 
0x0162 N/A N/A (Read Return 0x0000) 
0x0163 N/A N/A (Read Return 0x0000) 
0x0164 unsigned int16 0.01 inch/s Velocity (2Hz~1kHz) RMS, X 
0x0165 unsigned int16 0.01 inch/s Velocity (2Hz~1kHz) RMS, Y 
0x0166 unsigned int16 0.01 inch/s Velocity (2Hz~1kHz) RMS, Z 
0x0167 N/A N/A (Read Return 0x0000) 
0x0168 unsigned int16 0.01 inch/s Velocity (2Hz~1kHz) Peak, X 
0x0169 unsigned int16 0.01 inch/s Velocity (2Hz~1kHz) Peak, Y 
0x016A unsigned int16 0.01 inch/s Velocity (2Hz~1kHz) Peak, Z 

    

X Acceleration FFT (Peak) Data (Size: 6145) 
Address Data Format Unit Description (deltaF:13333.333/16384 Hz) 
0x0600 unsigned int16 0.001g X FFT Data (deltaF Index 0, 0Hz) 
0x0601 unsigned int16 0.001g X FFT Data (deltaF Index 1) 
0x0602 unsigned int16 0.001g X FFT Data (deltaF Index 2) 
… … … … 
0x1E00 unsigned int16 0.001g X FFT Data (deltaF Index 6144) 

    
X Acceleration Time Waveform Data (Size: 13334) 

Address Data Format Unit Description (deltaT: 1/13333.333 sec) 
0x1E01 signed int16 0.001g X Time Waveform Data (deltaT Index 0, 0 sec) 
0x1E02 signed int16 0.001g X Time Waveform Data (deltaT Index 1) 
0x1E03 signed int16 0.001g X Time Waveform Data (deltaT Index 2) 
… … … … 
0x5216 signed int16 0.001g X Time Waveform Data (deltaT Index 13333) 

    
Y Acceleration FFT (Peak) Data (Size: 6145) 

Address Data Format Unit Description (deltaF:13333.333/16384 Hz) 
0x5900 unsigned int16 0.001g Y FFT Data (deltaF Index 0, 0 Hz) 
0x5901 unsigned int16 0.001g Y FFT Data (deltaF Index 1) 
0x5902 unsigned int16 0.001g Y FFT Data (deltaF Index 2) 
… … … … 
0x7100 unsigned int16 0.001g Y FFT Data (deltaF Index 6144) 

    
Y Acceleration Time Waveform Data (Size: 13334) 

Address Data Format Unit Description (delta T: 1/13333.333 sec) 
0x7101 signed int16 0.001g Y Time Waveform Data (deltaT Index 0, 0 sec) 
0x7102 signed int16 0.001g Y Time Waveform Data (deltaT Index 1) 
0x7103 signed int16 0.001g Y Time Waveform Data (deltaT Index 2) 
… … … … 
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0xA516 signed int16 0.001g Y Time Waveform Data (deltaT Index 13333) 

    
Z Acceleration FFT (Peak) Data (Size: 6145) 

Address Data Format Unit Description (deltaF:13333.333/16384 Hz) 
0xAC00 unsigned int16 0.001g Z FFT Data (deltaF Index 0, 0 Hz) 
0xAC01 unsigned int16 0.001g Z FFT Data (deltaF Index 1) 
0xAC03 unsigned int16 0.001g Z FFT Data (deltaF Index 2) 
… … … … 
0xC400 unsigned int16 0.001g Z FFT Data (deltaF Index 6144) 

    
Z Acceleration Time Waveform Data (Size: 13334) 

Address Data Format Unit Description (deltaT: 1/13333.333 sec) 
0xC401 signed int16 0.001g Z Timewave data (deltaT Index 0, 0 sec) 
0xC402 signed int16 0.001g Z Timewave data (deltaT Index 1) 
0xC403 signed int16 0.001g Z Timewave data (deltaT Index 2) 
… .. … … 
0xF816 signed int16 0.001g Z Timewave data (deltaT Index 13333) 

Table 7. 0x04(4) Function Code Details 
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Fig. 7. Read 0x04(4) Function Code Flowchart (Refer to MODBUS APPLICATION 

PROTOCOL SPECIFICATION V1.1b) 
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8.  0x06(6) Function Code Details 
Address Data Format Default Description 

0x0000 unsigned int16 0x0009 

Baud Rate: 
0x0006:1200 bps 
0x0007:2400 bps 
0x0008:4800 bps 
0x0009:9600 bps 
0x000A:19200 bps 
0x000B:38400 bps 
0x000C:57600 bps 
0x000D:115200 bps 
0x000E:230400 bps 
0x000F: 460800 bps 
0x0010: 921600 bps 

0x0001 unsigned int16 0x0008 
Data Bits: 
0x0008: 8 bits 

0x0002 unsigned int16 0x0000 

Data Parity: 
0x0000: None 
0x0001: Even 
0x0002: Odd 

0x0003 unsigned int16 0x0001 
Stop Bits: 
0x0001: 1 bit 
0x0002: 2 bits 

0x0004 unsigned int16 0x0001 
Modbus Slave ID: 
0x0001~0x00F7: 1~ 247 

0x0200 unsigned int16 0xEEEE 

Table Data Update Trigger 
Write 0xFFFF to do Timewave and FFT 
calculation 
 
Use the function code 0x03 to read this 
value 
When register value=0x0000, use the 
function code 0x04 to get corresponding 
data. 

Table 8. 0x06(6) Function Code Details 
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Fig. 8. Write 0x06(6) Function Code Flowchart (Refer to MODBUS APPLICATION 

PROTOCOL SPECIFICATION V1.1b) 
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9.  0x10(16) Function Code Details 
Address Data Format Default Description 

0x0000 unsigned int16 0x0009 

Baud Rate: 
0x0006:1200 bps 
0x0007:2400 bps 
0x0008:4800 bps 
0x0009:9600 bps 
0x000A:19200 bps 
0x000B:38400 bps 
0x000C:57600 bps 
0x000D:115200 bps 
0x000E:230400 bps 
0x000F: 460800 bps 
0x0010: 921600 bps 

0x0001 unsigned int16 0x0008 
Data Bits: 
0x0008: 8 bits 

0x0002 unsigned int16 0x0000 

Data Parity: 
0x0000: None 
0x0001: Even 
0x0002: Odd 

0x0003 unsigned int16 0x0001 
Stop Bits: 
0x0001: 1 bit 
0x0002: 2 bits 

0x0004 unsigned int16 0x0001 
Modbus Slave ID: 
0x0001~0x00F7: 1~ 247 

Table 9. 0x10(16) Function Code Details 
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Fig. 9. Write 0x10(16) Function Code Flowchart (Refer to MODBUS APPLICATION 

PROTOCOL SPECIFICATION V1.1b) 
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10.  0x2B(43)_0x0E(14) Function Code Details 

 
 

 
 
 
 
 
 
 

 

 

Object ID Object Name Meaning Value 

0x00 Vendor Name Company name Wilcoxon 

0x01 Product Code Part Number Product Number (xxxxxxxx) 

0x02 MajorMinorRevision Firmware Version x.x.x 

0x03 Vendor URL Company website www.wilcoxon.com 

0x04 ProductName Device UUID 
12345678-1234-1234-1234-123456789012 
(Format is ”8-4-4-4-12”) 

0x05 Model Name Model Name 883M 
 

 

 

Table 10. 0x2B(43)_0x0E(14) Function Code Details 
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Table 10. 0x2B(43)_0x0E(14) Function code details 
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Fig. 10. Read 0x2B(43)_0x0E(14) Function Code Flowchart (Refer to MODBUS 

APPLICATION PROTOCOL SPECIFICATION V1.1b) 
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10.1 Example  

- Request message: ( 01 2B 0E 01 00 70 77 ) 
- Device address: 0x01 
- Function code: 0x2B 
- MEI type: 0x0E 
- Read Device ID Code: 0x01 (Get the basic device identification) 
- Object ID: 0x00 
"-CRC16" 
 
Receive messages: 
( 01 2B 0E 01 01 00 00 03 00 08 57 69 6C 63 6F 78 6F 6E 01 08 32 34 30 34 30 
30 30 34 02 05 32 2E 32 2E 37 F1 55 ) 
- Device address: 0x01 
- Function code: 0x2B 
- MEI type: 0x0E 
- Read Device ID Code: 0x01 
- Conformity level: 0x01 
- More Follows: 0x00 
- Next Object ID: 0x00 
- Number Of Object: 0x03 
- Object ID: 0x00 
- Object Length: 0x08 
- Object Value: ‘Wilcoxon’ (Company Name field in ASCII, 0x57 0x69 0x6C 
0x63 0x6F 0x78 0x6F 0x6E) 
- Object ID: 0x01 
- Object Length: 0x08 
- Object Value: ‘24040004’ (Product Number field in ASCII, 0x32 0x34 0x30 
0x34 0x30 0x30 0x30 0x34) 
- Object ID: 0x02 
- Object Length: 0x05 
- Object Value: ‘2.2.7’ (Revision field in ASCII, 0x32 0x2E 0x32 0x2E 0x37) 
"-CRC16" 
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11. 0x80(128) Error Code Details 

 

 
Table 11. 0x80(128) Error Code Details (Refer to MODBUS APPLICATION PROTOCOL 

SPECIFICATION V1.1b) 
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